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| update R&D WBS

Process: Costing Model Architecture Responsibility area: Master data management
@ This document describes the transactions related to the process of R&D project modification. Scope
The R&D projects aims to track costs of R&D projects. In order to facilitate the capitalization of qualifying ww
R&D projects, a time and cost-tracking system has been created using WBS (Work Breakdown
Structure) in the accounting ERP system (SAP). PE2
Frequency
On
demand
- %
References
Attachments

SBS-FRM-DRTR-02-019 - R&D
Project Creation Template.xIsx

| update R&D WBS

Guideline

| receive the request to update a R&D WBS

Change Project: Initial Screen Change Project: Initial Screen
STEP 1 AN AR5
If arequestis received to change_ —— o - -
project to Asset Under Construction Wes Element WBS Element |R-00sAux08s] =)
(AUC) you should go to CJ02, insert
the project code or WBS element
Enter |
code and
You will see all the WBS structure of (BL.) Ghange Project: WBS Element Overview

0 &P % R Summaraton

the project.

Proj. def.  [R-UDSATK0ES X085 Product development for D540/640

ABascoata | Dates | Assgnments Control | Total
S..L... WBS element Description Short ID T pi su P Al
1 RUOSAUX08S( X085 Product development for D540/640 ME-2015-03 RL @[~

1 R

STEP 2


https://wiki.syensqo.com/display/CostProc/Costing+Model+Architecture
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Considering that is not possible to
change the WBS codification, and
also not possible to change existing
settlement, as you can see by the
color (is not white) of fields of first line,
you should create a new WBS, filling
the second line of screen above, with
the same codification, but ending with
letter C (as for capitalization).

This new WBS will be set up for
capitalization using type R2 and
settlement to AUC as described in the
current procedure. Keep the same
WBS element codification (with C at
the end), the same Description and
the same Short ID; insert “2” in
column “Level” and “R2” in column
“Typ”; and select the same options of
the first line in the columns “Su”, “PE”,
“Acct” and “Bill”

STEP 3

Then you should select the first line
and go to “Settlement Rule”

Settlement Rule

On the Maintain Settlement Rule:
Overview screen, you should change
the settlement parameters to WBS,
tracking the menu “Goto” and the
option “Settlement parameters”,
inserting the code “ZPS12” in the field
of the Settlement profile and the code
“BG” in the field of the Allocation
structure.

STEP 4

[® . Maintain Settlement Rule: Overview
Hd» M ADE & panserdement

WS ekment  [R-CosaTMoES
X085 Product development for D540/640
Actual settlement

Dstrbuton ks
ot Settlment Receiver Receiver Short Text % Equbalence no. Amount A, Se... No. ... FromPesi.. From... To .. ToFi.. Frst (0]
CTR_TAF1000001 32103 100,000 0,00 1 10 2015 12 eses o1~

# .| Change Project: WBS Element Overview
& &2 % ] T Summarzation

Proj. def. [R-DOSATXGES X085 Product development for DS40/640

_4(BascData | Dates | Assignments | Responsbities | Control | Total

5. Level WBS element Description Tyo Pri Su |PE Acct BiT
1 RUDSAUXO8S X085 Kakx D540/640 - Next gen 2355 RL ¥ & -
R-UOSAUX085C X085 Kakx D540/640 - Next gen 2955 R2 v & >
1 RL
[E settlementrule Edt [ Goto | System  Help
@ Change Documents » on
Details F2

Maintain Se
K4 » MEADOE

Other rules...

R-UOSA

WBS element Settlement parameters F8
X085 Ki v
Actual settlement Views »
Back F3
Distribution rules
intail fe t Rule: F
K
WBS element R-UQSAUX0ES
X085 Kalix DS40/640 - Next gen 2955
Parameters
Description

Settlement profile ZPS12
Allocation structure BG|

PA transfer str-
Source structure
Asset Value Date
Hierarchy number

R&D - WBS->WBS (CE original)
RRD - WBS->WBS (CE 9370000000)

Strategy Sequence
Entered by PT63016524 lon 22.10.2015
Last changed by PT63022051 on 08.03.2016

(® .| Maintain Settiement Rule: Overview
M4 M DG ponsettement

WBS clement [R-UOSATKEES
X085 Kl DS40/640 - Next gen 2955
Actual settlement

Deirbuton ks
Cat Settement Recever
cTR._uAr1000001 RB8 2193€ 100,000 0,00 oL 1 10 s 2
W8S R-TOSATKOSSC 3 2014

A. Se... No. S... From Peri.. From... To... To .. Frst B
o6 o1, ~

Recewer Short Text % Equhalence no. Amount



Then you should click on “Back (F3)”

; insert the last period and the
current year in the columns “To
Period” and “To Fiscal Year” of first
line, relative to old settlement receiver;
insert “WBS” in the column “Cat”, the
code of changed project ending with
letter C in the column “Settlement
Receiver”, and the current period and
the current year in the columns “To
Period” and “To Fiscal Year” of
second line, as shown bi the screen
bellow; and press m two
times.

You will see in your screen the
following message

And you should click on
continue.

STEP 5

Then you should deselect the first line
and select the second line

STEP 6

You should go to settlement rule
Settlement Rule and

change the settlement parameters to
AUC, on the menu “Goto”, “Settlement
parameters”, and insert the code
“ZPS11” in the field of Settlement
profile and the code “BF” in the field of
Allocation structure

Finally, you should click on e twic

e and save by clicking on

STEP 7

If you go to CJO3 (display mode), and
insert the code of changed project you
can verify the new System status in
the column with same name as “REL
AUC".

STEP 1

If a request is received to change a
project to Fixed Asset

Go to CJ02 and select the project

(2 Settiement rule: Display messages

=

loued by sectiement prot

(o7 entry | @Hfée Technical information |[14][(«] [»] (1) (8] &) &) _curvent dsptay varant (@ prnt | B B8/@ 0 @ 0 (& 1 ][@ o N Heb %]

@ .| Change Project: WBS Element Overview

& & b =B summarzation

Proj. def.  [R-D0SAUX02S X085 Product development for D540/640

4 BasicData | Dates | Assgnments | Responsbities - Control | Total

S..|Level WBS element Descrption Short ID Typ Prijsu P Acct Balf]
Fsubdvded 05AUX085 X085 Kaltk DS40/640 - Next gen 2955 ¥E-2015-03 r M@ [~
2 RUDSAUX0SSC X085 Kalix DS40/640 - Next gen 2955 ME-2015-03 = | ORI -

1 R

[ .| Maintain Settle t Rule: P t
o

A

WES element R-UOSAUX0ESC

X085 Kalx D540/640 - Next gen 2955

Parameters

Description |
Settlement profie ZP511
Allocation structure BF|
PA transfer str.

Source structure

Asset Value Date

Hierarchy number

Strategy Sequence

R&D - WBS->AUC (CE 7211000000)
R&D - WBS->AUC (CE 7210000000)

Entered by
Last changed by

PT63022051 |on
PI63022051 |on

08.03.2016
08.03.2016

Display Project: WBS Element Overview
& &u % Bl T summarzation

Proj. def. R-UOSAUX085 X085 Product development for DS40/640

~ Basic Data Dates |~ Assignments . Responsbiities |~ Control _” Total
S..L... WBS element Short ID Typ Pi Su PE Acct Bl  System status

L Ruosauxoss ME-2015-03 Rl I s
ME-2015-03 R2 0@ @ _

2 R-UOSAUX08SC



STEP 2

Select the WBS/Line where you want
to create as final assets: Extras ->
Create completed Asset

STEP 3

Go to the next screen and complete
the missing information provided in

the request: Asset Class and Cost
center.

In the bottom of the SAP screen the
following message will appear:

STEP 4

Go the settlement rule of the WBS to
confirm you have a new line for the
final asset.

STEP 5

Then go back e to the previous
screen, in order to set up the project

as Technically completed: Edit -> Stat

us -> Technically complete.

Change Project: Initial Screen
H F

—
Project Def. R-TOSALXO26
WBS Element
[& poject Edt Goto WBSelement Detais [ Extras | System Help
@ -4 @@ | Projecsimmezton r8
Create document
Change Project: WBS Element  Deprecaton simubtion data
B e — Asset under construction  Ctri+Shift+F2
Greate completed asset
Proj. def.  |R-UOSALX026 X026 P Investment program Curlshift+FL
Settings
BascData | Dates | Assgnments | Responsbilties | Control | Total
S.. L.w. \WBS element Descrigtion Short D v
| 1 Ruosax2s X026 PPA for AutoJEE (AE4133) P 2

[E Create Asset:

Asset(s) to be created

Asset Class EZUSE4000
Company code [ asset 5782
Number of similar assets 1
["1Subnumber

Reference

Company code [ asset

Master data

Description X026 PPA for Auto/EE (AE-4133)

Inventory number
Business Area 3100

Cost Center HD37000010
Plant I3
Location

Additional data

1 assets created internally, and distribution rules created

WBS element R-U05ALX026
X026 PPA for Auto/EE (AE4133)
Actual settlement

Defautc distribution rules

Cat |Settlement Receiver  Receiver Short Text (% | Equivalence no. Se... No. S... Fro... From... To .. ToFi.. [Fisst Used Last Used

FXA 150000003370-0 X026 PPA for Auto/EE (.. 100,00 0 auc 1 o o
FXa  INTERM00001-0 X026 PPA for Auto/EE ( 1 o2 |

003.2013 005. 2013



STEP 6

Check if the status in WBS is "TECO".

STEP 7

The project can now be saved

Then, display again the project and
settlement rule, in order to find the
final asset number as below ( eg:
250000024135-0).

=g Project | Edit | Goto WBS element  Details Extras  System  Help
g sglect '@ CSHE DDhOa8n
Object >
C  Sstatus » Release
Project wersion Shift+F4 Lock
g
View » Unlock
Proj. def. Cancel F12 Order accepted _

< Basic Data | Dates - Assignments Ry

Technically Complete
Cancel close techn.

Fully invoiced ]
s..|L... 'WES element Cancel fully invoicd ]_
|| 1 RruosAxozel Close |
1 Cancel close v
1 Deletion flag V|
1 Cancel deletion flag v
1 User Status vl
1 System/User status =
1 BT ]
Proj. def,  [R-U0SATX026 X026 PPA for Auto/EE (AE4133)
BasicData | Dates |  Assignments | Responsbiities | Control | Total
5./L.. | WBS element: Short 1D Typ Pri [Su PE |Acct|Bil | System status
|1 RUosAX026 aM-6a8 R2 [ 4 [ [ TEco auc serc
WBS element R-UOSALX026
X026 PPA for Auto/EE (AE-4133)
Actual settlement
Default distribution rules
Cat |Settlement Receiver |Receiver Short Text L Equivalence no. Se... Mo. S... F
FXA 150000003370-0 X026 PPA for Auto/EE (.. 100,00 0 Uc 1 ]

FEA 250000024135-0 X026 PPA for AutofEE (..

1 FUL

Then, you must go to the transaction AS02, to change the Master Data of the Asset created.

STEP 8

Insert the Asset code and press Enter

Change Asset: Initial screen

Master data  Depreciation areas  Asset values
Asset 250000020490 (3
Subnumber 0
Company Code 5835

STEP 9

In the tab “Allocations”, you must insert the
code “E1” on the field “Evaluation group 4"

2



@ .| Change Asset: Master data

H B Assetvalues

Assot |2sooooozoas0] o | AB70 Surfactants consumption reduction
Class [zzTE1510] COSTI DI RICERCA Company Code | 5235/

General | Time-dependent ./ Allocations | Origin | Net worth tax | Insurance | Deprec. areas

| Allocations
Evaluation group 1 [}
Evaluation group 2 [ ]
Evaluation group 3 A
Evaluation group 4 | E1 | IDENTIFIABLE INTANGIBLE ASSETS
Evaluation group 5 "]

STEP 10

In the tab “Deprec. areas”, just verify if the
uselife of the asset is according to the
details of the request.

[® . Change Asset: Master data

B @ assetvales

e e—

Asset 250000020490/ |0 A670 Surfactants consumption reduction
Class [z1TE1510] COSTI DI RICERCA Company Code  |5835]
General L Tme-dcgendmt .&aﬁans ¢ Origin ; Met worth tax ; Insurance é@
ﬁ’. i
Vakiation [
A..|Depreciation area |DKey IffiseLie rd ODep Start  Index i
01fiscale 20 | O 5| 01.04.2016 =
02 civilstica 0000 | | 01.04.2016 =
16CAP+123456R, 0000 | 5 | 01.04.2016
20rival.1983 0000 | 01.04.2016
21rval.1991 0000 | 01.04.2016
22rval. 2003 0000 01.04.2016
25Affrancament 0000 01.04.2016
28 finanziament 0000 01.04.2016
30finanzament 0000 | | 01.04.2016
35ex01-fiscale ITBil‘ 5 ‘I 01.01.2016
32 IRAP tax 2201 | s | 01.04.2016
33Fscal IRAP 2201 \ s 01.04.2016
S0gestionale Zz01 \ 5/ 01.04.2016
T0assicurazion o000 | / 01.04.2016
80copa 01 cv 2201 "-,‘ k 01.04.2016
STEP 11

Finaly, you must run the settlement of the
Project or the WBS element, in order to start
the depreciation of the Asset created, by the
transaction CJ88.

Insert the WBS element code on
corresponding field, insert the period of the
start of capitalization on Settlement period
field, insert the current fiscal year, and
select the Processing type “Full Settlement”,
as shown on screen below.

Press Execute @ .



Actual Settlement: Project/WBS Element/Network

@
—_—
Project
or
WBS Element R-U0SBL132¢| (u]
or
| |
Network
[CJwith hierarchy

[CIWith orders

Settlement period 4 Posting period

Fiscal Year 2016 Asset Value Date
. I ETTrr—r——

Processing type Full Settlement -

Processing Options
[V Test Run

ot

[ Check trans. data

STEP 12

The last stage, is verify if the settled amount
corresponds to the total of R&D project
expenditures, by clicking on the Detail lists

, and you will see one screen like the

following one.
" Actual Settiement: Project/ WBS Element/Network Basic list

| @O
Selection
Selection parameters vake tame
WeS Bement RUOSELI28. A670 Surfactants consumption redu,,
Period 003
Postng pered 03
Facal Vear 2016
Processng tyve 8 Ful Settiement
Postng Date 31032016
Controling Area e %P SOLVAY
Cureney
Vae date 31032016
Processing Options
Selection Parameters Vale
Executon type ‘Seuement executed 5
Processng mode Tesun =
[[rocesing compieted wh oo arors
Statistics
Processng category T Humber
‘Satslgment exscviad 1
Mo change
ot reloans
Inagproprate siatus -
Emu -

Actual Settlement: Project/WBS Element/Network Detail list
pasic kst B | O sender Recewer [B] settementue [ A F B % & Msave [Bseea

Detail list - Settled values

Senders Receiers Short: text: Sender I ValiCOdrea Croy COArCur T Value in Obj. Croy | Ob.Cr/Send
WES R-U0SBL1328 XA SE35(250000020443/0 AG70 Surfactants consumption reduction 158.002,52 EUR 158.012,92 EUR

. 158.012,92 EUR " 158.012,92 EUR

Status
Owner RUSNAK-ext, Peter

Stakeholders = MCCARTNEY-ext, Stephen


https://wiki.syensqo.com/display/~rusn1635
https://wiki.syensqo.com/display/~mcca5123

Issue

The purpose of this Key Decision Document (KDD) is to elaborate on the solution recommended to manage indirect procurement process on the
new S/4HANA Cloud Private Edition SAP ERP system.

Recommendation

Background & Context

Currently, all indirect purchases for both goods and services are handled in SAP SRM7 that works with both ERP systems. EZBuy platform that is
built on top of SRM7 offers an “Amazon like” experience and serves as the gateway to Ariba Catalogs. Here, shopping carts for non-stock catalog
items are assembled and then sent back to SRM7 for the approval and ordering processes to proceed.

Ariba Catalogs are utilized by 14 countries, encompassing a total of 200 internal non-stock material catalogs and 140 punchout catalogs.

Bellow is the architecture of the existing procurement solution. EZBuy is just a frontend, the whole business logic and data are in SRM7.

?  Unknown Attachrment

Assumptions
Constraints
Impacts
Business Rules

Options considered

Indirect procurement, which involves the acquisition of goods and services that are not directly incorporated into a product being manufactured,
can be managed through various solutions, each with its own set of features and capabilities.

Option A: SAP SRM 7

SAP SRM 7 is a legacy procurement solution designed to optimize the procurement process, focusing on supplier collaboration and efficiency.

However, it is reaching the end of its lifecycle and it is not natively included or specifically designed to run as part of the SI4HANA suite. Its
Shopping Cart functionality was replaced with the S/I4HANA Self-Service Procurement functionality based on the Purchase Requisition document.

Option B: SAP S/AHANA MM

SAP S/4AHANA MM is part of the larger SAP S/4HANA Enterprise Resource Planning (ERP) suite, offering comprehensive materials management
and procurement functionalities. It is designed for businesses looking for an integrated solution that covers all aspects of their operations,
including procurement.

® Integration: One of the key strengths of S/4HANA MM is its deep integration with other modules within the S/4HANA suite, such as
Finance (FI), Controlling (CO), Sales and Distribution (SD), and more. This integration facilitates seamless data flow across
departments, enabling more efficient operations and decision-making.

® Functionality: SIAHANA MM provides a wide range of procurement functionalities, including purchase requisition, purchase order
management, vendor management, inventory management, and invoice verification. It supports both direct and indirect procurement
processes.

® Analytics: Embedded analytics in SIAHANA MM offer real-time insights into procurement activities, helping organizations to monitor
performance, identify bottlenecks, and optimize their procurement processes.

® Flexibility: While primarily designed for on-premise deployment, S/AHANA also offers cloud and hybrid options, providing flexibility to
businesses in how they deploy and manage their ERP systems.



Option C: Procure to Pay with SAP Ariba Buying (1ZM)

SAP Ariba Buying is a comprehensive cloud-based procurement solution designed to manage the end-to-end procure-to-pay process. It offers a
wide range of functionalities to automate and optimize procurement tasks.

Procure to Pay with SAP Ariba Buying combines the simple and elegant shopping experience and the user guidance of Ariba Buying and
Invoicing with integrated business processes and data transparency of SAP S/4AHANA Cloud as the digital core.

® Comprehensive Procurement Solution: It covers all aspects of the procurement process, from requisition to payment, including
supplier management, contract management, and spend analysis.

® Customization and Control: Offers extensive customization options to tailor the procurement process to the specific needs of the
organization. This includes custom workflows, approval rules, and integration capabilities with ERP systems like SAP S/4HANA.

* Collaboration and Supplier Management: Facilitates direct collaboration with suppliers through the Ariba Network, enabling efficient
communication, negotiation, and performance tracking.

® Spend Visibility and Control: Provides detailed insights into procurement spending, helping organizations to identify savings
opportunities and enforce compliance with procurement policies.

The following picture illustrates the process.

?  Unknown Attachrment

However, with the latest S/4HANA release this process became deprecated and will not be enhanced in upcoming releases.

Option D: Guided Buying with SAP Ariba Buying (2NV)

Guided Buying is an add-on capability to SAP Ariba Buying that focuses on enhancing the user experience by providing a simplified and intuitive
interface for procurement tasks. It is designed to help users make the right purchasing decisions in compliance with company policies. It
combines the guidance for requisitioners provided by guided buying with the proven procurement processes provided by SAP S/4HANA Cloud.

® User Experience: Guided Buying stands out for its user-friendly interface, designed to provide a consumer-like shopping experience. It
guides users to the right items and preferred suppliers, making it easier for employees to purchase goods and services in compliance
with company policies.

® Policy Compliance: Guided Buying helps enforce procurement policies by guiding users to approved suppliers and negotiated
contracts, thereby ensuring compliance and leveraging pre-negotiated savings.

® Spot Buy Capability: Includes features like Spot Buy for handling non-sourced or emergency purchases by accessing a curated catalog
of suppliers for immediate needs.

® Integration: While Ariba can be used as a standalone procurement solution, it also offers integration capabilities with SAP S/4AHANA and
other ERP systems, ensuring data consistency and process efficiency across platforms.

® Supplier Network: Ariba's extensive supplier network is a significant advantage, offering access to a wide range of suppliers and
enabling competitive sourcing, supplier discovery, and collaboration.

In this scenario, employees create requests for catalog items, existing materials, planned lean services, limit items for material and service, or
free-text items by adding them to a request in Guided Buying. Then the request is replicated to SAP S/4HANA Cloud, where a purchase

requisition is created. In the request in Guided Buying, employees can see the document numbers of the follow-on documents that were created
in SAP S/4HANA Cloud.

?  Unknown Attachrment

Evaluation

For organisations running SAP S/4HANA Cloud, Private Edition, the recommended indirect procurement solution is Guided Buying with
SAP Ariba Buying (2NV) that combines the guidance for requisitioners provided by guided buying with the proven procurement processes
provided by SAP S/4HANA Cloud.

While SRM7 and

Option A Option B Option C Option D
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Change Project: Initial Screen
AR

STEP 1

To update the settlement rule of
project to cost center, go to CJ02 and
insert the code of project.

Project Def. R-U0SAUX024 O
WBS Element

(@ .| change Project: WBS Element Overview
& & & % = T summarzation

STEP 2
Proj. def.  [R-U0SAUXQ24 X024 High Heat PPA
Select the line related to project and BascD3 | Dates | Assgrments | Responsbices | Control | ‘Total
S..L... WBS element Description Short ID T Pri Su PE
Setﬂerﬂent RUE T 1 RuosaUxozs X024 High Heat PPA Ru-838 mvp m =
click on . d =

[#® .| Maintain Settlement Rule: Overview
I 4 » M & D E ad & phbn settlement
WBS element R-UOSAUX024

X024 High Heat PPA
Actual settiement.

Distrbution rules
Cat  Settlement Receiver Recewver Short Text % Amount. Equivalence no. A..Se... No.
WBS R-UOSALK024 X024 High Heat PPA 100,00 PER 1
B —


https://wiki.syensqo.com/display/CostOP/CJ02+-+Update+settlement+rule+to+WBS?sortBy=name&sortOrder=ascending
https://wiki.syensqo.com/display/CostOP/CJ02+-+Update+settlement+rule+to+WBS?sortBy=date&sortOrder=ascending
https://wiki.syensqo.com/pages/viewpage.action?pageId=20873845
    /display/~crollier

https://wiki.syensqo.com/pages/viewpage.action?pageId=20873847
    /display/~crollier


Maintain Settlement Rule: Distribution Rules
STEP 3 o

-y
Settlement Sender
'WBS element R-UOSAUX024
B I ” X024 High Heat PPA
Click on “New rule (F9) and compamycote[o35d] L
change the field “Valid to” to previous :
N Actual settlement
period.
Settlement Receiver
'WBS Element R-UOSALX024
Distribution Rule
Number 1] Vald from 3 J2014]to ([5 |2014
Settlement type  |PER|
Percent 100,00(%
[Equivalence no.
Amountin EUR Amt rule type || settle Each Period
Strategy ]
= Settlement rule  Edit | Goto | System Help
STEP 4 e Change Documents 3 amon
Detais F2
G_o back to the previous screen and Maintain Se -
click on the menu “Goto”, “Settlement M4 b W @O Peresne
parametgrs", an_d insert the code L Other rules...
ZPS10" in the field ?f S(’?t_tlemen_t WES element [RU0SH  Settlement gammeters  F8
profile and the code “BE” in the field of 024 H )
Allocation structure e Views N
Back F3
Distribution rules
Cat  Settlement Receiver Receiver Short Text % Amount
WBS R-UOSALX024 X024 High Heat PPA 100,00
A313 H2TRUST-FP7 N.325357
STEP5
Parameters
« S Description
Change the “Settlement profile” to ZPS s —
10 and “Allocation structure” to BE Settlement profile 2PS10 | R&D - WBS -> CHEOPS CCtr
’ Allocation structure BE R&D - WBS->CHEOPS CCtr
PA transfer str. []
Source structure []
Asset Value Date
Hierarchy number ]
Strategy Sequence [
L= sethement fule | Edk | LOTO  System  Help
STEP 6 & Hewnle P H@ CDHE HDLOHD
Delete rule
. Mainta  cancel F12  le: Overview
Go back to the previous screen and —
M 4 » M & O [E a8 &% Phn settlement
click on “New rule (F9) or go to WES element R U0SADRO24
the menu Edit, New rule. X024 High Heat PPA
Actual settlement
Distribution rules
Cat Settlement Receiver Receiver Short Text % Equivalence no.
W8S (JoosaLxo24 X024 High Heat PPA 100, 00

STEP 7

Inform the new Cost center and the “V
alid from” to the period the project
should start being settled using the
new settlement rule.



Maintain Settlement Rule: Distribution Rules

Number: New settlement rule number L&
(sequencial).
Settlement Sender
WBS element R-UOSAUX024
lemen . PER
Settlement type X024 High Heat PPA
. Company Code 5978
Percent: if 100% or less A
Settlement Receiver
Cost Center NDF10RBBOA|
Oider
Distribzliun Rule
Number 2 Vald from 6 | 2014 to,
Settlement type  |per
Ly ol
Parcent 100 s
L A
Equivalence iic:
Amountin EUR Amt rule type Settle Each Period
Strategy ]
|%® .| Maintain Settlement Rule: Overview
H4 » 1 DG & pan settiement
STEP 8 WES element R-UOSAUXO24
X624 o et p7A
Al satherent
Go back to the previous and now, you T
should find the two settlement rules e L M e s e
moenE A5 10,0 Y

Go back e to the previous screen

and save it

Change Project: Initial Screen
AT

STEP 1

To update the settlement rule of
project to order, go to CJ02 and insert
the code of project.

Project Def. 'R-UO5AUX024 e
WBS Element '

Change Project: WBS Element Overview

LB E T summeaton

STEP 2
Proj. def.  [R-UosAux024 X024 High Heat PPA
Select the line related to project and _AlBastata | Dates | sssgnments | Responsbites | Control_|Total
. Settlement Rule 5L WBS semert Descrotion St T P (s b
click on . 1 RUDSAUX024 X024 High Heat PPA a3 R m u
1 R
Maintain Settlement Rule: Overview
STEP 3 M 4 » » & O [ adda Pln settiement
WES clement [R-U05AUX024
. « X024 High Heat PPA
Then you should click on “New rule R
Dtrbution rules
(F9)” , or click twice on the line Cat | Sattiement Receiver Recever Short Text % Amount Equivalence no. A, Se... No.
Of the Settlement rule WES ’l_z—wsuxwzq »_XHE High Heat PPA 100,00 PER 1

and change the field “Valid to” to
previous period, as ilustrated.



Maintain Settlement Rule: Distribution Rules

o

VS
Settlement Sender |
P et
WBS element R-UOSAUX024
X024 High Heat PPA
Company Code 5978

Actual settlement

Settlement Receiver

WBS Element R-UOSALX024
Distribution Rule o
[ — — =
Number 1 Valid from 3 |2014|to 5 | 2014
Settlement type  |PER
—
Percent 100,00(%
)
Equivalence no.
Amountin EUR Amt rule type || settle Each Period
Strategy

[& gettlementrule  Edit | Goto | System Hebp

STEP 4 V] 1 Change Documents 'l oamoo
| Detais F2
Go back to the previous screen and Maintain Se o e
click on “Go”to" and “Settlement H4>»N&EDBR revious rule
parameters”. L | Other rules...
WBS element m Settlement parameters F8
X024 H  Overview
Actual settlement Views 3
Back F3
Distribution rules
Cat | Settlement Receiver Receiver Short Text % Amount
WBS R-UOSALX024 X024 High Heat PPA 100,00
SUEPS | Parameters
Description | |
Change the “Settlement profile” to ZPS Settlement profie ZP510 | RED - WBS -> CHEOPS CCtr
10 and “Allocation structure” to AP. e e m niE
PA transfer str. ]
Source structure []
Asset Value Date
Hierarchy number [
Strategy Sequence
L= Settlementrule | Edit | Goto System  Help
STEP 6 & Hewnle P 5@ CHE DDOHD
Delete rule
Go back to the previous screen and Slalnta ore 2 eOuemiewy
click on “New rule”. K 4 » M & D E &b & ehnsettlement
'WBS element R-UOSAUX024

X024 High Heat PPA
Actual settlement

Distribution rules
Cat Settlement Receiver Receiver Short Text % Equivalence no.
W8S (JvosaLxo24 X024 High Heat PPA 100, 00

STEP 7

Inform the new Cost center and the “V
alid from” to the period the project
should start being settled using the
new settlement rule.



Number: New settlement rule number
(sequencial).

Settlement type: PER

Percent: if 100% or less

STEP 8

Go back to the previous and now,
you should find the two settlement
rules

STEP 9

Go back e to the previous screen

_

If the below message appears

and save it

Delete the old settlement rule, by

clicking on “Delete rule”

Then go back e to the previous

screen and save it

Maintain Settlement Rule: Distribution Rules

A&
| Settlement Sender
WBS element R-U0SAUX024
X024 High Heat PPA
Company Code [s97¢|
Actual settiement
| Settiement Receiver
Cost Center [
Order [07026PR05672]
[ Distribution Rule
Number [27] Valid from T:zuu:tn 1 1
Settlement wpe  |per]
Percent [100 s
Equivalence no. ]
Amountin EUR Amt rule type Settle Each Period
Strategy ]

(% .| Maintain Settlement Rule: Overview
H 4 »H&E

WES doment  [RD0SATX024
X024 High Heat PPA

Actualsettement

Receiver Short Text % Amount
X026 Hoh WeatPPA 160,00
FAESOLVN 5672 100,00

Equisknce no. |A. Se. Ho.[S... FromPeri...From.. To... ToFi.. |
= s 2014 5 a0

"R 2 € 204

LIxt

Typ|Message text

W@ |Receiver categ. WBS is not allowed by settlement prof. ZPS10 for this-|(®)

Maintain cttlement Rule: Overview
M < » M & (][ qd sz Pln settlement

R-UOSAUX024
X024 High Heat PPA

WBS element

Actual settlement

Send an e-mail to the Controller confirming that the R&D WBS was updated.
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